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Copyright and disclaimer 
All rights reserved. No parts of this manual may be reproduced in any form without the express 

written permission of Makin AS (Makin). Makin makes no warranties, express or implied, with 

respect to this document or its contents. In addition, the contents of the document are subject to 

change without prior notice. Every precaution has been taken in the preparation of this manual. 

Nevertheless, Makin assumes no responsibility for errors or omissions or any damages resulting 

from the use of the information contained. 

 

Copyright © 2019-2025 by Makin AS. 

Contact the manufacturer: 

Makin AS 
Vognvegen 23 
2072 Dal 
NORWAY 

www.Makin3D.com 

E-mail: info@Makin3D.com 

Org. no. 920 323 650 

  

http://www.makin3d.com/
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1. Introduction 
1.1. Congratulations on your new product  
You are now ready to work more efficiently and keep the precision at an optimum level. Besides that, 
you will be more eco-friendly by doing the same amount of work in less time. 

The system is designed to show you the information you need on the screen with the greatest 
accuracy. 

At the construction site, you are the expert - Makin’ 3D is the best work companion you can get. 

We at Team Makin wish you all the best with the use of your new system. 

 

 

1.2. Maintenance  
It is recommended to check the system's accuracy regularly. We recommend that the operator of 
the machine frequently checks the positioning against a known point on every job site. See Chapter 
13.3: Check the calibration of your excavator. 

 

 

1.3. Storage 
Keep the equipment safe when it's not installed in the machine. Use of a protective case is 
recommended if the tablet and antennas are removed from the machine to secure the devices from 
external stresses such as knocks and bumps. 

 

 

1.4. Cleaning 
The equipment must be cleaned regularly to ensure full functionality over time. 

Cleaning is done by blowing to remove dust, you can also choose to use a damp cloth to wipe the 
tablet. 

Under no circumstances should the equipment be high-pressure washed - neither inside nor outside 
the engine compartment. 
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2. Responsibility 
2.1. Installation 
All installation and main calibration of the system must be carried out by Makin approved technical 
personnel. Failure caused by unauthorized installation or repair could cause a void of warranty. 

It is important to follow the machine manufacturer's instructions for installing the Makin machine 
control system to avoid violating any machine supplier's warranty regulations. 

The user is responsible for using the product in accordance with the given instructions. The user is 
also responsible for ensuring that the reference models used are correct and that the bucket is 
properly calibrated and controlled. 

Broken cables on the system may cause short circuits, system errors, and defective components. 
Ensure that no cables have external damage; damage must be repaired immediately before further 
use. 

Errors in measurement results may occur if the equipment has been subjected to impact, abuse, 
modification, or transport damage. Control of the system after such events is important to ensure 
an optimum result. 

Warranty: For further details, visit www.Makin3D.com for more information. 

 
 

2.2. Limitations 

The product is intended as a control tool, and any use beyond this is not permitted. The supplier or 
manufacturer cannot be held responsible for any use that goes beyond the given limits. 
 

The Makin’ excavator system is designed for utilization specifically on an excavator equipped with a 
standard bucket. The application of our system on an excavator featuring alternative attachments, 
such as hydraulic hammers or grapples, is not within the intended use of the Makin’ excavator 
system. Such use falls outside the defined scope, and Makin cannot be held accountable for any 
instances exceeding the specified limits. 

 
 

2.3. End-user license agreement 
License: The system is preloaded with software, which can also be downloaded with permission 
from Makin. The software is protected by copyright and other laws. The use of the software is 
governed by the license agreement entered into with the Makin’ 3D system when purchasing the 
product.  

http://www.makin3d.com/
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For further legal terms and conditions, including but not limited to the applicable End User License 
Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.  
 

 

2.4. Warranty disclaimer 
Makin provides this documentation without warranty, term, or condition of any kind, either implied 
or expressed, including, but not limited to, the implied warranties, terms, or conditions of 
merchantability, satisfactory quality, and fitness for a particular purpose.  
Makin, its employees, and agents will not be responsible for any loss, however arising, from the use 
of, or reliance on this information. 
 

For further legal terms and conditions, including but not limited to the applicable End User License 
Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.  
 

 

2.5. Software update 
Software will be automatically and frequently updated, and users will get a notification on the screen. 
Software updates require a valid maintenance license. To start downloading an updated software 
version, users will be asked to agree before the download starts.  

 

 

  

http://www.makin3d.com/
http://www.makin3d.com/
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3. Product overview 
3.1. Hardware Excavator 3D 

Hardware overview 

 

 
 

 

 1. Bucket sensor  6. Machine sloping sensors 

 2. Tilt sensor for sideways bucket angle. 
360-degree tilt-rotator (Optional) 

 7. Interface Box for system power and 
data communication 

 3. Stick angle sensor  8. Tablet w. machine control software 

 4. Boom height sensor  9. GNSS receiver 

 5. City boom sensor (Optional)  10. GNSS antenna 
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3.2. Tablet buttons and light indicators (Panasonic FZ-A3) 

 

1. 1. On/Off button 6. 4. Quick access to tablet's menu 

2. 2. Volume up 
 

7. 5. Not in use. The button can be 
programmed (16.7. Tablet set-up). 
 
6. Not in use. The button can be 
programmed (16.7. Tablet set-up). 
 

 3. Volume down 
 

 

 

Additionally, screenshots can be taken by pressing the ‘On/Off button’ and ‘Volume down’ 
(simultaneously holding down buttons 1 and 3 for about two seconds). This can be useful in the 
unfortunate case where assistance is required. Find the screenshots via the ‘Photos’ app. 
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3.3. Software 

3.3.1. How to turn the system on 

1) Turn on your Makin’ 3D system by pressing the on/off button on the tablet. Android will start 
up and present the ‘Lock screen’. 
 

2) Swipe upwards with one finger on the touchscreen to access Makin’ 3D. 
 

3) If no project has been previously loaded, you will be prompted to do so. See Chapter 4.1: 
Open or create a project. 

 

 

3.3.2. Elements of the work screen 

Makin’ 3D offers a variety of screens to choose from. Below is a description of one that includes 

most of the available visual features. 
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1. Top bar with status indicators for 
connectivity. It also contains features for 
resetting the pan and zoom level as well 
as changing between screens. 

6. Tap the bucket (also in the static views) 
to change or calibrate the machine’s 
bucket. 

 
 

Station: Indicate where on the centerline 
you are located. To the right of the 
Station, you can see the slope along the 
road 

CL: Distance to centerline. To the right of 
the CL, you can see the slope across the 
road. 

Height: Name of current Height Reference 

Side: Name of the current Side Reference. 
 

 

 

 

 

 

Change the height offset according to the 
current reference - e.g. the specified plane 
or the loaded model file. 

 

Quick keys are shortcuts to features 
found in the menu. 

2. Indication of the slope in the main 
direction of the tool point. The arrow 
indicates the vertical distance to the 
selected height reference. The arrow will 
change color depending on the distance 
to the target. Tap the indicator to change 
the height tolerances. 

7. 

3. Indication of the slope in the cross 
direction of the tool point. The arrow 
indicates the horizontal distance to the 
selected side reference. The arrow will 
change color depending on the distance 
to the target. Tap the indicator to change 
the side distance tolerances. 

 

 

 

 

 

4. Info bar for Easting, Northing and Height 
coordinates. 

    8. 

 

5. Tap any element in the loaded 3D model 
to bring up the References dialog. 

9. 
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3.3.3. Touch gestures 

Gesture Action 

 

Use one finger to rotate a 3D View. 

 

Use two fingers to pan a Top View or 3D View. 

 

Spread or pinch two fingers to respectively zoom in or out of a Top View or 
3D View. 

 

Tap to select. 

 

Sometimes it is possible to long-press for further options. 
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3.3.4. Symbols in the top bar 
 

Symbol Function 

 

Indicating a connection to the internet. The symbol appears white when a 
connection is established and gray if there is no connection. 

 

Indicates the number of visible satellites. hRMS (Horizontal Root Mean 
Square) and vRMS (Vertical Root Mean Square) indicate the current GNSS 
accuracy. Tapping the icon will bring you to the GNSS status menu. 

 
Indication of synchronization of data between server and machine. 

 

An indication that you have remote support from Makin. 
This will usually be in connection with a remote support case where you will 
be notified. 

 

Bring your machine back to the center of your screen after zooming and 
panning. 

 

Placed in the upper right corner. Tap for a change of screen, depending on 
the work you are doing and what you want to have in focus. 

 

Toggles between 2D (top view) and 3D view. This button is always placed on 
the work screen that it toggles. 

 

Indicating project offset. The symbol appears when a project offset is applied 
to the active project. 

 
The tablet is connected to the cloud. 

 
Synchronize to the cloud. 

 
The tablet is not connected to the cloud. 

 
The tablet is disconnected from the cloud because of a secret project. 
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This symbol is a sensor status indicator. See the pop-up notification for 
more information.  

3.3.5. Quick keys on work screen 

Illustration Menu ID Function 

 

References Tap to access the References menu. Another way to access 
this menu is to select an element in the 3D model. 
 
NB! 
Long hold to access the Project menu. 

 

Log point Tap to quickly log a point, which will be stored alongside 
general as-built data.  
 

NB! 
The name of the current object is shown on the icon’s label. 

 
NB! 
Long hold to access Objects. You need to select an object 
before logging a point.  

 

Log line Start logging a line by adding line log points.  
 

NB! 
You can select a line and edit it. Select it as a Point of 
Interest, name it, and add a comment to it. You can also edit 
the line point’s offset. You need to select an object before 
logging a line. 

 

Disable log line Stops the line logging. 

 

Bucket menu Tap to access the Bucket menu. 

 

Main menu Menu from where you can access all features of the 
system. 
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Main menu 
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4. Project 
Working according to any kind of design is considered a project, whether it is a simple relative plane 

or referencing lines and surfaces in more complex 3D models. 

 

 
 

 

4.1. Open or create a project 
To open an existing project: 

1) In ‘Project’ tap ‘Open project’ to see all the projects stored. This dialog is automatically 

opened if no project is loaded. 

 

2) Tap on the project you want to open, and the download starts. 
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3) If you want to create your own local project, tap the ‘+’ icon. 

 

 

4) Tap on the local project icon. 
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4.1.1. Create a secret project 

You can create a secret project that will only be available on your tablet and will not synchronize to 
the Makin’ Cloud. Secret projects are useful for construction projects needing confidentiality due to 
security, critical infrastructure, or competitive advantages. 
 

1) Go to project > Open project. 
 

2) Tap on the ‘+’-symbol. 
 

3) Tap on the ‘secret project’ icon. 

 
 

 
4) Name the secret project. 

 
 
The icon in front of the project name indicates that it is a secret project: 
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4.1.1.1. Remote control for secret projects 

If you need support while working on a secret project, you must grant support access to your tablet 
during remote control. The secret project is disconnected and does not synchronize with the Makin' 
Cloud, as indicated by this icon: 

 

The support staff can see that your system is online on the Makin' Cloud, but they will not have 
access to any details about the secret project. To get support while working on a secret project, you 
need to give access to the support staff. When the support staff initiates remote control, a 
notification will pop up on your tablet: 

 

 
 
 

To allow remote control access, tap on the check mark. 
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4.2. Transfer files 
You can transfer files via USB flash drive to secret projects, local projects and cloud projects. You 
can import files to the project and export as-built data from the project. Please note: If you import 
files to a local project or a cloud project, those files will be available on Makin’ Cloud. For more 
details, see section 4.2.1.1: Imported files on Makin’ Cloud. 
 

1) Tap on the ‘transfer files’ icon. 

 

 
2) Choose between import to project or export as-built data from the project. Learn more about 

importing and exporting in the sections below. 
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4.2.1. Import to project 
You can import files to the project via a USB flash drive. You cannot import single files but only 
folders from the USB flash drive. Please note: If you import a file with the exact same name as an 
existing file in the project, the new file will overwrite the existing one.  

 
How to import files to the project: 

1) Important: Insert the USB flash drive into the tablet first. 

 
2) Tap on ‘Import to project’. 

 
 

 
 
 

3) You will now be directed to Android's dialog. 
 

4) The first time you insert the USB flash drive you need to make sure that the USB flash drive 
is selected. Tap on the ‘three stripes’ icon in the top left corner. 
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5) Tap on the name of the USB flash drive to open it. 
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6) Tap on the folder you want to import files from. 
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7) Tap on ‘select’. Please note: All the files in the folder will be imported. You cannot import 
single files.  
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8) Import of files is completed. You can view the files under Project > References. The 
imported files will be marked with a *.  
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4.2.1.1. Imported files on Makin’ Cloud 
When you import files to a local or cloud project, they will be available on Makin’ Cloud. However, 

these files will be stored in your system’s project folder, and not as part of a global project within 

your organization. 

 

How to find imported files on Makin’ Cloud: 

1) Go to Makin’ Cloud > Choose organization > Systems 
 

 

 

2) Select the system that imported the files. 

 

3) Open the project folder under that system. 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        30 

4) Select the project where the files were imported. 
 

 

 

 

5) The imported files will be available in this folder.  

 

 

 

4.2.2. Export as-built 
The USB export function allows you to export locally logged as-built data directly to a USB stick. 

This makes it possible to transfer project data without requiring access to the cloud. 

 

Note: Only the as-built data logged by the current user can be exported. 

 

When performing a USB export, the following files are generated: 

• LandXML file: Contains points and lines from the as-built logging. 

• ZIP file (attachments): Photo documentation for all images linked to the logged points. 
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Steps to Export As-Built Data via USB: 
1. Insert the USB flash drive into the tablet. Please note that it is very important that this is done 

as the first step. 

2. Open the menu Open project.  
3. Tab the icon displaying the two arrows (Transfer symbol)  
4. Tap on ‘Export as-built’. 

 

 
 

5. You will now be directed to Android's dialog.  
6. Make sure that the USB flash drive is selected. If not, tap on the ‘three stripes’ icon in the 

top left corner and select the USB flash drive. 
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7. Tap on the folder where you want to save the as-built data. 
8. Tap on ‘Select’. This will export the project’s as-built data to the chosen folder. A pop-up 

notification will indicate that the export is in progress.  
• Please note that in most cases, the process is completed so quickly that this notification 

may not appear. 
 

 
 

9. The project’s as-built data is now saved in the selected folder on the USB flash drive. When 

the export is complete, a confirmation pop-up will be displayed on the screen. 
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4.3. Supported file types 

When creating a project, the following file types are supported: 

• LandXML Roadrunner format (XML) 

• Drawing eXchange Format (DXF) 

• Norwegian coordinate and observation format (KOF) 

 

New projects are stored in LandXML format. 

 

4.3.1. Project filter 

Note: When Makin’ 3D reaches 170 MB data in size, a warning will pop up, informing you that the project 
is large. This can reduce performance. The file size depends on the complexity and the details in the 
model.  
 

 

 

If the project reaches 170 MB data in size, part of the model will be shown on your tablet screen near 
the application, while the rest remains hidden. As you move the application around, the visible part 
of the model will adjust to stay aligned with where your application is.  

 

You can choose to load a part of the project file under Project > Project filter or click ‘Filter’ in the 
notification (see picture above).  
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1) Select the folder you want to activate and load by clicking on the button. When the folder is 
activated, the button will turn blue. 
 

 
 

2) Deselect the folders you do not want to load by clicking on the button in front of the folder’s 

name. When deselecting the folder, the button will turn off. 
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The activated folders will be loaded and displayed under ‘References' in a petrol blue color, along 
with the files from the folders. 
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You can create folders on Makin’ Cloud and then drag your project files into these folders: Makin’ 

Cloud > Project > Choose your project > New folder. 

 

 
 

4.4. References 
In the ‘References’ dialog, you can choose which part of the 3D model should be active/inactive and 
what should be selected as height references, side references, and alert references.  

Height references can be points, lines, and surfaces. 

Side- and alert references can be points and lines. 

 

 

 1. Tap one of the symbols to select all 
elements in the project 

 4. Green is used for elements that may 
reference the height. Press to select as 
reference. Long press will deselect all 
other height references selected  

 2. White means an element is visible and 
activated 

 5. Red is an alert reference, which gives a 
warning when the tool is too close to the 
element. Not applicable for surfaces. 
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 3. Blue indicates an element used as a 
side reference. Press to select as 
reference. Long press will deselect all 
other side references selected 

 6. Highlight elements with yellow color in 
the 3D model 
 
 
 

 

As an alternative to going via the menu, you can also find this feature in the Quick Keys menu or by 
selecting any element in the 3D model. 
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4.4.1. Folders 

In the reference examples below, we see all the data that has been entered on a road parcel. 

 

 

 

In this example, we have six folders: 

• Road Models 

• Water & drain 

• Electricity 

• Construction 

• Landscaping 

• Sewage 

 

If you enable options (i.e., set visible, side reference, height reference, alert reference) for a folder, 
you enable the option for all models in the entire folder. For example, if you have many road models, 
you may want to open the folder with the small gray arrow to the left of the folder and only activate 
the road models that you need. 
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Folders are shown in blue text - model files are white. File and folder names are scrollable, indicated 
with a tiny yellow arrow to the right of their names. A star following a project name indicates the 
project is local. 

In the above example, we have opened the folder for road models, which contains several individual 
files. You can turn on all elements of a folder or turn on some details by expanding individual folders. 
Within the folders, you can select specific data to make visible and choose what to actively work 
against. 

To get an indication of the different model files, side and/or height must be activated. As with 
viewing, you do this by tapping the respective blue and/or green boxes. By enabling visibility, side, 
and height in combinations, you can customize what information you want on the screen. 
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4.4.2. Visible reference 

All geometries are visible by default and can be hidden by deselecting the white square next to them, 
beneath the eye symbol. Calculations are only performed according to visible layers. 

 

 

 
 

For example, if we want to make all roads visible in a group of models, simply check the white box 
to the right of its folder. It will make all roads visible on the screen. If we only want to see one road, 
just activate the white box to the right of the particular road file. 

 

 

 

4.4.3. Side reference 

Side references are geometries used for side calculations. When models are activated, they have a 
blue color next to them, beneath the symbol with the horizontal arrow in the ‘Reference’ dialog. The 
closest geometry, activated for side reference, will automatically be used. Lines and points can be 
selected as side references - not surfaces. The calculated side distance is the horizontal distance 
to the geometry. 
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4.4.4. Height reference 

Height references are geometries used for height calculations. They are indicated with a light green 
color when activated in the ‘References’ dialog, beneath the vertical arrow symbol. The lowest 
geometry, with height reference enabled, will automatically be used. Height references are typically 
surfaces, but lines and points can also be selected for height calculations. 

 
 
 

4.4.5. Alert reference 

Alert references are geometries used for alert calculation. The closest geometry activated as an 
alert reference with a red square beneath the warning symbol will automatically be used. Lines and 
points can be selected as alert references - not surfaces. Unlike the calculation of side reference, 
the calculated alert distance is the closest Euclidean distance (shortest path) to the geometry. 

 
 
 

4.4.6. As-built data 
As-built data is data used for documentation of the performed task. As-built data can be used in 
different ways: to document that the project is built the same way as it was originally designed or to 
document if extra work has been performed, e.g., how much soil is being removed from an area.  
 
The as-built data is collected when the machine works, and the data is logged by the operator. These 
data can be used later in the process to assure the quality of the project and/or to calculate the 
volume of material that is added or removed from an area. As-built points will be saved in the 
overview if it is necessary to navigate to the points at a later stage of the project.   
 
As-built data can be used as references in a similar way as other references. The green points are 
your own points, and the purple points are points from other applications. The lines and points are 
continuously saved and synchronized to the Makin’ Cloud, where they can be downloaded as .CSV, 
.KOF or .XML formats. 
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4.4.7. Lock Reference (line, point, or surface)  

Makin can work with multiple active references at the same time. This allows the user to activate 
and work with the references when moving the tool point over them. The active reference will 
automatically switch to the one closest to the tool point. While doing this, and with a lot of references 
often close together, it can be difficult to avoid the references from switching if you want to navigate 
to a specific height or side reference or to a reference further away than other selected references. 
In this case, the user can lock a reference, isolating the navigation to this specific reference without 
deactivating all other active references.   

You can select and lock a line, point, or surface that will be used as a reference.  

If you are moving the tool point around on the project, the height and side reference will keep being 
locked to the selected reference, thus keeping this as the reference.  

 

Locking a reference can be done in the reference menu or directly on the work screen:  

1) Select an object by pressing the object name or directly on the visualized object on the run 
screen.  
 

2) Press the lock icon to lock the selected reference. 
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3) Select ‘Side’, ‘Height’, or both: 

 

 

You can see that both ‘Side’ and ‘Height’ have a lock on them. 

 

 

4) If you want to unlock it again, just tap once on the lock, and it will disappear. 

 

5) If you want to lock the reference directly under your tool point, this can be done by pressing 
the lock icon next to the reference name on the work screen. This will toggle the lock icon 
between open and closed for either height or side reference. 
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4.4.8. Dynamic 2D files 

2D files, also known as background files or display models, are defined as files with no height 
information available. The height of all points in the file is set to 0.00 meters. These files are often 
used as background to visualize existing infrastructure or drainpipes where height was not logged 
originally. When working on projects with 2D files, they are not placed at a height of 0.00 meters. 
They are moved closer to the project, right below the active 3D references' lowest point. These files 
are handled dynamically, so whenever a 3D reference is activated or deactivated, the 2D files adjust 
accordingly.  
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4.4.9. Copy Point 
You can now copy and edit a point by selecting one from the design model. However, it should be 
noted that you are not able to modify the points in the design model itself. 
 
By using the edit feature, you can change the point's properties, such as its height. The edited point 
will be saved under your own points list (user model). 
 
Additionally, you can utilize the Copy Point feature to duplicate any points from your personal point 
list. 
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4.4.10. Stakeout 

Stakeout is showing the information for the selected line, point, or point on a line. To stake out an 

element, press the element in the graphics or press the element name in the reference dialog, and 

press the stakeout icon at the top of the reference dialog. A popup will appear with all the stakeout 

information for the selected element. The stakeout menu can be freely moved around on the tablet. 
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Measurement: Shows measurements between the tool point and the selected reference for the 
stakeout. 
Reference: Shows information about the entire selected reference for stakeout. 
Segment: Shows information about the active line segment (gray line). Only shown for lines that 
contain segments. 

 
1. Horizontal distance between tool 

point and selected reference. 
Measured perpendicular to the line. 

8. Horizontal length of stakeout line. 

2. Vertical distance between tool 
point and selected reference. 

9. Length of stakeout line. 

3. Inclination between selected 
reference and tool point. 

10. Segment type can be line, arc, or clothoid (spiral, 
transition curve). 
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4. Stationing of the selected line.  11. Horizontal length of line segment. 

5. Horizontal distances from present 
stationing to the end points of the 
active line segment (colored gray). 
The line will be extrapolated, if the 
tool point is in front or behind end 
points. In this case, the value will be 
negative to the closest end point. 

12. Length of line segment. 

6. Name of selected stakeout line. 13. Height difference of the line segment.  

7. Type of selected reference (arc, 
circle, line, polyline, road line) 

14. Slope of the line segment. 
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4.4.10.1. Stakeout to a point 

When you want to stake out to a point, you can press the point or click on the name of the point in 

the reference dialog, and then press the stakeout icon .  

A bullseye and a popup with the stakeout information will appear on the screen. The blue line in the 
bullseye indicates the long slope direction, and the red line indicates the cross-slope direction.  

The popup with the stakeout information will show information about measurement and reference.  
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4.4.10.2. Stakeout to a line 

When you want to stake out to a line, you can press the line on the screen or click on the name of 

the line in the reference dialog, and then press the stakeout icon .  

A dotted line from the application to the selected line will show on the screen, along with a popup 
with stakeout information. The stakeout information will show information about measurement, 
reference, and segment.  

If you move beyond the line, the dotted line will show the extrapolation of the selected line. Please 
note that if you stake out to a side reference, the line does not extrapolate.  

 

 
 
 
 

  



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        51 

4.4.10.3. Stakeout to a line point 

If you want to stake out to a point on a line, you must press the arrow between the line symbol  
and the name of the line in the reference dialog. Then the name of the line point will appear 
underneath the arrow. Select the line point you want to stakeout to, and then press the stakeout icon 

. 

     

 

A bullseye and a popup with stakeout information will appear on the screen. Like stakeout to a point, 
the blue line in the bullseye indicates the long slope direction, and the red line indicates the cross-
slope direction. 

The popup with stakeout information contains information about measurements and references. 
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4.4.10.4. Stakeout to side reference 

You can stake out to side references, which allows you to see multiple elements’ information by 
jumping between them when you use the stakeout feature.  
 

How to use: 

1) Activate the elements you want to use as a side reference by pressing the boxes underneath 
the blue horizontal arrow in the reference dialog. When you activate a box with a blue edge it 
will change to a fully blue box.  
 

2) Press the stakeout icon . 
 

3) The application will now stake out to the nearest element, and when you move around, the 
application will switch to stake out to a new nearest element. A popup with stakeout 
information will also appear on the screen.  

The popup with stakeout information will show information about the name of the element, 
so you know which element the application stakes out to. The popup also contains 
information about measurements and references.  
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4.4.11. Create point from coordinate 

1) Press on References: 

 

 

2) Press the ‘+’: 

 

 

3) Press the point icon:  
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The point will have the coordinates of the bucket’s selected measurement point. 
 

 

 

4) Set a name for the point. 
 

5) The point’s coordinates can be adjusted manually. 
 

6) It is also possible to adjust the bucket’s position and fetch the new position of the bucket 
(see the bucket icon in the picture above). 
 

7) Tap the check mark to confirm the new point. 

 

Points you have created yourself can be found at the bottom of the References under User model > 
Points. 

 
 

 
 

4.4.12. Create line from points 

1) From ‘References’ tap ‘+’ and then ‘Line’. 

You can create lines between existing points - either from a design model or from points you have 
created yourself. 

The line will be created in the order in which points are selected, and you will see how the line appears 
in the on-screen overview. 

2) You will be prompted to ‘Select the points for the line’. 
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3) Select the points individually by either picking points in the 3D visualization or highlighting 
the yellow icon next to them in the list. 
 

4) Finish by pressing ‘OK’. 
 

5) Give the new line a name. 
 

6) If you have selected three points or more, you can select the ‘Close line segment’ option to 
connect a line between the first and last points. 
 

7) Finish the line by pressing ‘OK’. 

 
 
 

4.4.13. Create profile along lines 

1) From ‘References’ tap ‘+’ and then ‘Profile’  .      

The line will function as the centerline for the profile, where you can add any number of surfaces on 
either side of the line. 

2) You will be prompted to “Select the lines for the profile”. 
 

3) Select the lines for the profile in the 3D visualization or in the list. When done, tap ‘OK’. 
 

4) Give the profile a name. 
 

5) Press the ‘+’ button on the left and right side of the screen to respectively add new surfaces 
on the left or right side of the line. 
 

6) Adjust each of the surfaces’ width, Deltaheight dH, and angle according to the design that 
you want. 
 

7) You can also adjust the height offset of the entire profile. 

 

 

4.4.13.1 Edit profile 

You have the possibility of editing an existing profile. In this way, you can edit the profile’s width and 
slope of the surfaces, as well as add or remove surfaces.   

1) Under User model; longhold on the profile surface name, which you want to edit. 
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2) Click on the pen tool, which will appear.  

 

 

3) Adjust the width, the deltaheight dH, and/or the angle of the surfaces by clicking on the 
numbers you want to change. 
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4) The profile will now change according to the new width and slope of the surfaces.  

 

 
 
 

4.4.14. Edit Line 
You can edit line points in the user model if you need to change the coordinates/location of an 
existing line. Be aware that you can only edit your own lines located under the user model, meaning 
that you cannot edit lines from project- or As-built data.  
 

1) Go to References > User model > Lines. 
 

2) Click on ‘Lines’.  
 

3) Choose the line you want to edit by clicking on the line or the arrow in front of the name of 
the line. For example: 

 
 

4) Click on the point of the line you would like to change, for example: 
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5) Click on the pen tool to edit the line point. 
 

6) Change the desired coordinates of the point’s position. The line will now change in relation 
to the point’s new position.   
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4.4.14.1. Copy a line from design data in order to edit it  
Because you cannot edit lines from design data, you can instead copy a line from the design and 
edit the copied line points in the User model. In this way, you can still follow the line and make 
adjustments to the line points, e.g., if you want to change the height of a line point.  
 
How to copy a line: 

1) Select the line you want to copy from the design. 
 

2) Click on the ‘Copy’ icon:  

 

3) You can rename the copied line. Press ‘Ok’ to copy the line. 
 

4) The copy is now under ‘User model’, where you can edit the line.  
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4.5. Infield Design  
To open the Infield Design function, go to the Reference menu.  

 

1. Click the + icon on the menu bar in top of the Reference menu.   

2. This will open a drop-down menu. Select the Infield Design icon.  

 

 

 

3. Wait for the Infield Design section to open.  

 

 

 

4.5.1. Points and lines in Infield Design 
The Infield Design is equipped with an Add point- and an Add line-button.  
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, SUUse these to add the needed data or work from already logged data. The workflow when 

logging points and creating lines in Infield Design is almost the same as when logging regular as-

built data.  

 

1. Click the icon for the data you need to log.  

2. Place the tool point in the correct position.  

3. Click the Add point from TP-button on the screen. This will log a point.  

 
 

4. Move the tool point to the next position.  

5. Repeat until all desired points are placed and click the OK button.  
 

Please note: If you close the pop-up window by pressing the X, all data created before pressing OK 

will be deleted, and it is not possible to recover it.  
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4.5.2. Info box for line 
When a line is created, you can access its relevant information. Simply select the line and click the 

Info-button on the left-hand side of the screen. This will open a pop-up window. 

 

 

 

 

4.5.3. Create a boundary  
1. When the points are logged, click the Add surface-button.   
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2. Click the Boundary-button. 

 

 
 

3. Select the points there are a part of the boundary and click OK. 

 

 
 

4. A boundary has been created.  
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4.5.4. Calculate volume  
1. Start by creating a surface based on your boundary.  

2. Click the Add surface-button.  

3. Click the Boundary-button and select the created boundary. When selected press OK.  

 
 

4. Select the top points to create the surface. When the points are selected, click OK to create 

the surface.   
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5. Select the surface and click the Volume to boundary-button to calculate the volume. 

 
 

6. This will open a pop-up window showing the volume.  

 
 

7. If more information is needed, click the Info-button to open the info box.  
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4.5.5. Infield Design report   
It is possible to create an Infield Design report with all the relevant measurements. Create the 
report by clicking the Make report-button, this will export the data to Makin’ Cloud. Please note that 
the report can only be generated once the volume has been calculated and Infield Design has 
collected all the relevant data. 
 

 
 
Go to the cloud and open the PDF. Please note that the image in the report is a screenshot taken at 
the moment when ‘Make Report’ is clicked. It is therefore important to be aware that the screen 
displays the measured area if you want to have the correct area shown in the report. 
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4.5.6. Exiting Infield Design  
To exit the Infield Design click the Exit Infield -button or the Infield Design icon at the bottom of the 
screen.  
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4.6. Fix point control 
If a construction site has set up fix points, then the points will not be visible for the machine operator 
in the Makin’ 3D app. To find the fix point control, go to Project > Fixpoint control. 

 

 

 

If there are no fixed points in the project a warning will pop up. 
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How to do a fix point control: 

1) Mark the tool point by tapping on the bucket.  
 

 

 

2) Choose the correct tool point. 
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3) Go back to the fix point control by tapping on the arrow. 
 

 

 
4) Go to the next step by tapping on the arrow in the bottom right corner.  
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5) Locate the fix point. Navigate the machine to the nearest fix point by following the side 
distance in the top left corner. 

 

 

 

6) Open the bucket and place it on the fix point. Follow the picture on the screen by placing 
the open bucket with the tool point on the fix point. 
 

7) Tap ‘Measure’. 
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8) Close the bucket and place it on the fixed point. Follow the picture on the screen by closing 
the bucket and placing it again with the center tool point on the fix point.  
 

9) Tap ‘Measure’. 
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10) The report for the fix point control is displayed on the screen. It shows the difference 
horizontal and vertical for both the open and closed bucket.  

 

 

 

11) Tap on the check mark.  

 
 
 
 

4.7. Geodetic systems 
Only in rare cases should the machine operator be concerned about selecting the correct coordinate 
system and geodetic model. With Makin’ 3D these matters are handled in a central place - e.g., the 
construction office. When made available, the geodetic system cannot be changed on the excavator. 
It is possible though, to handle the geodetic system locally when required by simply not having it 
preselected for a particular project. 
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4.8. Extend surface 
Extending the surface allows you to continue your excavation even if you are beyond the design that 
is already at hand. By selecting ‘Extend surface’, you extend the road surface you are working on - 
even if the actual design has limitations. The same is true for cuts where the cutting surface is too 
short for you to find the cutting top. 

 

 

 

 

The way the surface extends depends on the file format you are using:  

Road formats: For road formats like road lines and xml. files, the surface will extend perpendicular 
to the centerline when you select ‘Extend surface’. 

Other formats: For surfaces with other formats like dxf. and landxml. the surfaces will extend with 
a heading cut across, when using the feature ‘Extend surface’. It means that the extended line will 
move along with the bucket’s cutting edge. 

Note that when you extend the surface, only the current tool point’s height will be shown when you are 
beyond the design. Only one height will be calculated, which will be the height from the active tool point. 

 

 

 

 

 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        75 

Extend surface using road formats: 

 

 
 

Extend surface using other formats: 

 
 
 

 
 
 
 
 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        76 

4.9. Plane 
By activating the ‘Plane’ feature, you get a virtual reference plane, which can be either flat or sloping 
with a 1-sided or 2-sided fall. 

 

 
 

 

Use ‘Main direction’ and ‘Main slope’ to indicate the plane’s longitudinal direction and angle. 
Likewise, set the transverse slope of the plane with ‘Side slope’. 

With the ‘Elevation’ option, specify the absolute elevation height or quickly get the current height of 
the tool point. Another option, called ‘Set plane here’, also uses the current tool point height, but with 
the addition of taking the reference height offset into account. 

When the plane is active, you can tap the visual part of the plane to quickly change its values. When 
you no longer need this feature, it is important to disable the plane. If you do not do this, the activated 
plane will follow the machine wherever it may be located. 

Tap to activate and deactivate a virtual plane and change the longitudinal direction, longitudinal 
slope, and transverse slope. 

If you set the height manually and then enter a longitudinal fall, the point for starting the slope will 
still be below the "cross thread", which forms the center of the measuring point on the bucket. Those 
are the E and N coordinates that you can see in the upper left corner. It is important to keep in mind 
that the measuring point on the bucket is above the desired starting point for length/cross slope. 
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4.10. Temporary profile 
Toggling the ‘Profile’ option turns the temporary profile on or off while its settings are retained. 

There are two options for moving the profile, respectively ‘Set profile here’ and ‘Set profile & 
direction here’. The first option horizontally displaces the profile and positions the middle of its 
centerline at the tool point. In addition, the latter option also rotates the profile according to the 
heading of the bucket/attachment. 

Adjusting the ‘Slope’ will tilt the profile along its baseline. 

Under ‘Edit profile’ you can change the profile’s contours by adding and removing surfaces as well 
as changing the width and slope of the surfaces. Changing slopes can be done either by specifying 
the height difference between two surfaces or by specifying the percentage slope between them. 
Also, you can specify a height offset for the profile, where the baseline is indicated by a gray line in 
the 3D view. 
 

 

 

 

The profile can be rotated by using ‘Edit direction’. North corresponding to 0 (zero) degrees. The 
feature ‘Get direction from tool’ will align the profile according to the bucket/attachment. 

As an alternative to going via the menu, you can jump to this feature by tapping the profile in the 3D 
view. 
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4.11. Project offset 
Project offset is designed to adjust a machine's height to match the height of the design project you 

are working on. Even if a machine is correctly calibrated, the height measured by the tool point in 

the application can differ from the height of a known point on the project. These differences can 

occur as a result of differing reference systems, e.g.: localized coordinate projections vs. official 

coordinate projections. Other sources include small variations between GNSS manufacturers as well 

as incorrect heights used in the initial project design. 

To mitigate this, we have added the project offset functionality, which adjusts the received GNSS 

height (not the antenna height) to match the height of the known point on the project.  

 

Note: 

You must ensure that the machine is calibrated correctly before adjusting the project offset. 

Project offset is limited to adjustments of +/- 50 cm. 

 

Project offset can be adjusted in: Main Menu > Project > Project offset 
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How to use: 

1) Inside the project offset menu, you will see the tool point height of your application in the 

value area.  

 

 

 

2) Enter the correct height of the known point in the value area to calculate a project offset. 

 
3) It is also possible to adjust the project offset using the +/- buttons, increasing or decreasing 

the value by 1 cm per tap.  

 

4) A project offset is calculated and visible in the project menu. When you have a project offset, 

the icon will be visible on the work screen.   

 

 

To remove the project offset, go into the Project Offset menu and tap the trash can icon. 

 
 
 
 
 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        80 

4.12. Change offset 
 

 

 

 
 

Entering this menu adjusts the height offset you want to have for the whole project. Typical uses are 

where you have only been given the surface of a road and should dig for a ditch or other layers 

beneath the surface. If the ditch is known to be 0.85 meters under the finished road, then adjust the 

offset value to -0.85. A parallel surface/line will then be created 0.85 meters beneath the theoretical 

model. The whole model will be offset.  

You can enter the desired value manually or move your finger up or down in the vertical field. 
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If you have applied an offset but want to view the model with its original offset, enable 'Show Original 

Model'. 
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5. Display 
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5.1. Labels 
A label is the name of a geometry object of the following type: 

• Points 

• Lines 

• Surfaces 

• Stations 

• Log Points 

• Log Objects 

• Texts 

 

It is possible to choose which type of label should be visible by selecting/deselecting it on the list. 
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5.2. Screen indicators  
It is possible to hide some of the screen indicators in the work screen area. This function is 

designed to let you remove non-essential features, that could be distracting on the screen.  

 

With all screen indicators:  

 

 

With selected screen indicators:  
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5.3. Dark theme 
By default, the machine control system has the ‘Dark theme’ enabled, which is great at nighttime or 
when working in dimmed conditions. It is recommended to disable this feature when working in a 
bright environment, especially while working in direct sunlight when staking out points outside the 
cabin, etc. 
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5.4. Show maps 
The user can hide or show maps along with the project to get a better overview. The map will be 
shown below the lowest active 3D reference in the project. 

The tool cuts are shown on the map in Top View. Otherwise, tool cuts are only shown on elements 
of the 3D model marked as a height reference. 

Note: In the 3D View, the map will be seen in a perspective view. If you want to see it straight from 
above, use the Top View instead. 

 

• Tap to select/deselect visibility of map 
 

    

 
  



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        87 

5.5. Transparent surfaces 
Hide the surfaces to be able to see lines and points beneath them. 

Note: Surfaces with textures will not be transparent. 

Warning: Reference selection is not visible when transparent surfaces are enabled. 
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5.6. Show textures 
Instead of using solid colors, you can have textures shown. This is only possible with road geometry. 
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5.7. Tool point coordinates 
You have the option to show or hide the tool point coordinates in the app. When activated, the 
coordinates for north and east will be displayed along with the height. If deactivated, only the height 
will be shown. 
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5.8. Machine speed 
This feature ‘Machine speed’ shows the speed of the machine, working like a speedometer. The 
speed is displayed in kilometers per hour (km/h). When activated, the speed will appear in the top 
left corner. 
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5.9. Reverse quick keys 
This feature places the quick keys to the right of the menu button. It makes it more convenient to 
log points from the right-hand side of the screen without having to visually locate the point logging 
feature. 
 

       
 

 
 
 
 

5.10. Auto hide quick keys 
Auto Hide Quick Keys will hide the “quick keys” at the bottom of the screen after about 8 seconds of 
not touching the display. 

When you touch the display, they become visible again. It will give you a clearer view of what you are 
working on when icons are hidden. 
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5.11. Show other systems 
Other systems currently working on the same project - like machines, rovers, etc. - will show up. 
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5.12. Use file color 
This feature changes between using the colors stored on file or the default color scheme of Makin’ 
3D. In some situations, it gives a better overview using the colors of the model file and will make it 
easier to separate elements in a complex file.  

If file color is not enabled, Makin’ 3D will use default colors. 

Be aware that some files can include black-colored lines or designs, and these will not be visible if 
file color is selected. 

 

Tap to select/deselect file colors 
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5.13. Wireframe 
Tap Wireframe to enable the triangular design to be visible. This will show the edges of the triangles 
and might improve their visibility. 

 

 
 

 
 
 

 

5.14. View settings 
To obtain a better overview of your work, you now have the option of hiding the excavator or making 
it transparent. 
 
Open the menu and select Display. Scroll down to View settings. 
It is possible to set this individually for a work situation or when you touch the screen. You can also 
choose individual settings for runscreens with 3D View or Top View. 
 
You can now easily toggle between 3D View and Top View by pressing the icon in the upper right 
corner. 
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Menu > Display > View settings > Top view 

         

 

Menu > Display > View settings > 3D view 
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5.15. Change screen 

This option is to change the working screen. Tap the icon in the top right corner and select the 
workscreen option you want to display. 
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6. Settings 
 

 

 
 
 
 

6.1. Tolerances 
Tolerances are thresholds for calculations. They are used for different indications, like colors and 
sounds. You can change the tolerances for height, side, and alert. 

When working outside the specified tolerances, the indicator in question is shown in white color. 
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6.1.1. Height tolerances 
1) Tap ‘Height’. 

 

2) Tap ‘Heigh tolerance’. 

 

 

3) Choose any of the 3 options (Red, Yellow, Green). 
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4) Enter the tolerance. 

 

 

 

The ‘Yellow’ band for the height tolerance indicates a distance for when to start showing that you 

are near a selected height reference. 

‘Green above’ and ‘Green below’ are the limits for the accepted height deviation, respectively above 

and below the reference. As long as your measurements fall within these green zones, the deviation 

is within the allowed range, and the job meets the required standards. 

‘Red’ is an indication of excavating too deeply into the ground. The tolerance is an expression for 

when to ignore the warning when you are far below the reference. 

The sound option will enable different sounds depending on the band within which you are working. 

There will be no sounds when working above the yellow band and below the red band. 
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6.1.1.1. Snap to surface 

If you have multiple height references activated, you can select whether the tool point should snap 

to the lowest or the highest surface. This means that when height references for multiple layers are 

active, the tool point will automatically snap to either the lowest or the highest surface, depending 

on your chosen setting. 

 

1) Go to Settings > Height. 

2) Tap on ‘Snap to surface’. 

 

 

3) Choose between ‘Lower’ and ‘Upper’ to snap to the lowest or highest surface depending on 
your preference. 

 

  

4) The tool point will now snap to the lowest or upper surface depending on your chosen setting. 
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6.1.2. Side tolerances 

For the side distance, ‘Red’ means that you are approximately within reach of your target, and ‘Yellow’ 

means that you are even closer. The ‘Green’ band indicates the accepted deviation from the target. 

Keep in mind that the side distance is calculated horizontally and is not the shortest path. 

 

1)  
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2)  

 

 

3) Choose any of the 3 options (Red, Yellow, Green). 

 

 

 

4) Set the tolerance. 
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6.1.3. Alert tolerances 

The tolerance for alert is divided into Show, Warning, and Danger. 

• If you are in the ‘Show area’, a red 3D line will be shown. 

• If you are in the ‘Warning area’ you will get a warning notification saying, “Too close”. 

• If you are in the ‘Danger area’ you will get a danger notification, and an alarm will sound if 

turned on.  
 

1)  

 

 

2)  

 

 

3) Choose any of the 3 options (Show, Warning, Danger)  
 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        104 

 

 

4) Change the distance you want from the point of alert. 
 

 

 
 

You will have a sound option as well. Activate the button for sound or deactivate it for mute sound. 
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6.2. Measure time 
For the most accurate measurement in the Makin’ 3D app, you can adjust the measured time 

settings. You can also improve accuracy by allowing the sensors to stabilize and reducing 

surrounding noise from GNSS by delaying the measure time. 

 

  

 
 

In the 'Measure time' menu, you will see two functions: Measurement time and Delay time. These 

settings allow you to fine-tune the measurement process for the most precise results. Learn more 

about how to use these settings in the following paragraphs. 
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6.2.1. Measurement time 

When you use the 'Measurement time' function, you can specify a duration for the Makin’ 3D app to 

measure. This feature accounts for GNSS fluctuations by averaging the data for greater accuracy. 

For instance, if you set the measurement time to 1 minute, the app will calculate the average position 

after one minute for a more precise reading. 

 

1) Tap on Measurement time 
 

 

 

 
2) Set your desired measurement time. 

 
 

 
 

 
 

3) Tap on the check mark to save.  
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6.2.2. Delay time 
With the 'Delay time' function, you have the option to postpone the measurement process in the app. 

This delay allows the sensors to stabilize before capturing your position, leading to more accurate 

results. For instance, setting a 2-minute delay means the app waits for 2 minutes before starting to 

measure your position. 

 
1) Tap on Delay time. 

 

 
 
 

2) Set the desired delay time. 
 

 

 
 
 

3) Tap on the check mark to save your selection. 
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6.3. Language 
Select the language of your choice. The language is automatically changed and saved. 

 

     

 

 

 

 

6.4. Length unit 
Tap to choose the length unit. It is automatically changed and saved. 
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6.5. Angle unit 
Tap to choose the angle unit. The angle unit is automatically changed and saved. 

 

     

 
 
 
 
 

6.6. Sound Volume 
Tap the sound volume again and again to change the sound level. Choices are given: Low, Medium, 
High, Highest. 
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6.7. Area selection  
The ‘Area selection’ feature makes selecting objects in areas with many elements (such as points, 

lines, or surfaces) easier. When you tap on an area with multiple elements, a list of up to 7 nearby 

objects will appear on the screen, which you can choose from by tapping on the object you want to 

select. The objects listed are the ones closest to the spot you have most recently tapped. A ring will 

briefly appear on the screen to indicate the area you are selecting. 

 
 

     
 
 
 

You can enable or disable this feature in the Settings menu. When ‘Area selection’ is disabled, only 

one object will be selected when you tap on the screen. 
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6.8. Leveling meter 
In the Leveling meter menu, it is possible to turn on or off the height indicator on corner tool points. 

It is possible to select between Fixed or Moving arrows. 

 

      

 

The green bars indicate the surface below the bucket when the plane has been selected. 
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The arrows and numbers in the circles indicate how far and in what direction you should move the 
bucket to match the surface below. 
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6.9. External buttons 
If you have a configurable joystick, you can set up the functionality here. 

1) Choose the button you want to configure. 

2) Choose between No action, Change of tool point, Log point, Zero plane. 
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7. Logging (As-built) 
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7.1. Log Point 
Log Point is an as-built feature used to document points. You can access it from the Logging 

menu or by long-pressing the shortcut on the work screen. 

 

Option A Option B 

  

 
 

1) Tap ‘Object’. A list of your most recently used objects will appear. 

If no objects are shown, click the folder icon, then select a group of objects to find the one 
you need. 
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2) Choose the object group that suits your task. 

 

 

 
 

3) Select the relevant object from the list. 
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4) Once the object is selected, tap the Log point icon in the bottom right corner to log a point. 
 

 
 
 

5) A notification will confirm the point has been logged, including the point number and object 
details. 
 

  

 

You can press ‘undo’ if you regret your last logging. The confirmation pop-up will disappear after 

approximately 10 seconds. 

Note! The last used object will remain active until it is changed. 
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7.2. Log Line 

Log Line is an as-built functionality used to document how points are connected. Log Line can be 

used to document line breaks where there are changes in slope, direction, or if the project requires 

it, to document every line junction. 
 

How to log a line: 

1) Press and hold the Log line icon at the bottom of the screen for three seconds  

 

 

 

2) Choose the object that matches your task. 
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3) You can start logging a new line in one of two ways: 

a. Option 1: By clicking the ‘+’ icon located in the bottom right corner. 

 

 

b. Option 2: Close the menu and then click on the log line icon on the work screen. 
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You can add line points by tapping the icon (see picture above). 

4) To stop this line, press the cancel log line button at the top of the work screen.  

 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        121 

7.2.1. Log a new line from an existing line 

It is possible to log a new line from an existing line. For example, you can easily log a line junction 
for a sewage project by logging a new line from an existing line. 

 

How to: 

1) Click on the line on the work screen, or go to Project > References, and activate the line by 
clicking on its name.  

 

 

2) Click the gray arrow to expand the line and view the line points in the Reference dialog. 
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3) Choose the line point from where you want to start the new line and activate the line point by 
clicking on it. 
 

4) Click on the ‘Log line’ icon. 
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5) You can now log a new line from an existing line. 
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7.3. Switch between logging points and lines 
You can log lines and points at the same time. You can, for example, log a line by short-pressing the 

log line icon at the bottom of your work screen, and when you want to log a point, you can simply 

short-press the log point icon. Even if you move the machine after logging a point, it remains in log 

line mode, allowing you to log points at the same time.  

 
 

Line logging-mode Logging a point while logging a line: 
 

  
 
 
 

7.4. Own objects 
You can create your own objects this way: 

1) Select Logging in the menu. 
 

2) Select ‘Object’. 
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3) Tap the folder icon. 

 

 

4) In ‘Object group’, select ‘Own objects’. 
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5) Tap ‘+’. 

 

 

6) Name your object. 

 

 

7) Tap the check mark to save. 
                        
 

The new object is now stored under ‘Own objects’ and is automatically selected as the default object 
for point logging. 
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7.5. Attributes 
If attributes have been created in Makin' Cloud, you can add them to the points, lines, and line points 

you want to log. For more details on creating attributes in Makin' Cloud, see section 7.8: Create 

objects and attributes on Makin’ Cloud. 

 

 

 

Attributes are characteristics and information that describe a logged point, line, or line point in as-

built documentation. For example, attributes can include details like dimensions, materials used, or 

the type of measuring point, etc. The attributes you can use depend on the objects and groups that 

have been created for the project in Makin' Cloud. 

 
 
How to add attributes: 

1) Find the appropriate object for your task. 

 

2) Select the attribute you want to add to the point or line. 
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3) Enter or choose the relevant information for the attribute. 

 

 
 

4) If needed, add more attributes by selecting them and filling in the details. 
 

5) Tap the ‘Log point/Log line’ icon in the bottom right corner. 
 

 
 
 

6) The point or the line is now logged with the added attributes.  
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7.5.1. Custom attribute 
You can create custom attributes for your own objects in the Makin’ 3D app. For example, a custom 

attribute can help make the office aware of an unknown cable or notify others about unexpected 

items. 
 

1) Tap on ‘Object’ and select ‘Own objects’. 

2) Choose the object relevant to your task. 

3) Tap the attribute icon. 

 

 

 

4) Enter the details for ‘Title’ and ‘Text’. 

5) Tap the ‘+’ button in the bottom right corner. 
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6) The custom attribute is now added to the object.  

7) You can create and add more custom attributes if needed. 

8) Tap the Log button in the bottom right corner to log the point or line. 

 

 

 
 
 
 

  



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        131 

7.6. Log offset 
You can log an offset for both point and line point heights: 

 

1) Go to Coordinates > Log offset 

        

 

 

2) Enter the measurement for the offset. 
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3) Click on the check mark. 
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4) The result will show two numbers for the height, like this: (0.00) -1.35. The number in the 
parenthesis is the logged point's height, and the number after the parenthesis is the 
calculated height after applying the offset. 

 
5) Click on the log point icon in the bottom right corner. 

 

 
 

6) You have logged an offset for the point or line point: 
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7.6.1. Edit a log offset 
 
To edit a log offset for a point or a line point: 
 

1) Go to Project > References 

 
2) Click on the point or line point name. 

 

 

 

3) Click on the pen tool to edit. 
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4) Go to ‘Coordinates’. 

 
5) Click 'Log offset’. 
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6) Set the offset and click on the check mark. 
 

7) Click on the check mark in the bottom right corner. 
 
 

 

 

8) The offset is now edited. 

 
 
 
 

7.7. Photo 
You can add photos to the as-built documentation by taking photos of objects you want to call 
attention to and document. 
 

1) Log a point or line point. 
 

2) Edit the logged point or line point: 

a) Option A: Click on ‘Edit’ in the notification 

b) Option B: Long-press the point on the work screen. Click on the pen tool.  
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c) Option C: Click on the point’s name in the reference dialog. Then, click on the pen 
tool.  

 

3) Click on the tab ‘Photo’ 

 

 

 

 

4) Click on the camera icon to take a photo of the desired object 
 

 

 

 

5) Take the photo by clicking on the camera icon. 
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6) Click on the check mark. 

 

 

 

 

7) Click on the checkmark in the bottom right corner to confirm the editing. 
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8) Your photo has now been saved as as-built data for the logged point. 

 
9) The photos used for documentation can be downloaded as as-built data from Makin’ 

Cloud. 

 
 

 

 

 

7.8. Create objects and attributes on Makin’ Cloud 
You can create objects and attributes for a project on Makin’ Cloud. Objects and attributes can be 

created in a specific project or set as default project files. Please note that if you create objects and 

attributes as default project files, they will be available in all new projects in the organization on 

Makin’ Cloud.  
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For a specific project:  

Makin’ Cloud > Choose organization > Projects > Select project > Attributes 

 

 

 

Default project files:  

Makin’ Cloud > Choose organization > Settings > Default project files > Attributes 
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7.8.1. How to create objects 

1) Click on ‘Edit’ to begin creating a new object. 

 

 

 

2) First you need to add and name the group, e.g. Sewage. 
 

 

 

 

3) Add subgroups for more details. For example, if the group is ‘Sewage’, you can add a 

subgroup called ‘Wastewater’. 
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4) Add and name the object. 
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5) You can add an ID to the object and choose the relevant applications and geotypes where 

the object can be used. Click on the icons to select or deselect. Icons will grey out when 

deselected. 

 

 

6) Add more objects if needed. 
 

 

 

 

7) Click ‘Save’ to save your changes. 
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7.8.2. How to create attributes 

1) Click on ‘Edit’. 
 

2) Add and name the attribute. 
 
 

 

 

3) You can choose which applications and geotypes you want the attributes. 
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4) You can also add further information in the form of number, text, or list under ‘Type’. The 

chosen type decides how the user of the application can add details to the attribute: 

 
 

a. Number: The user can enter a number on the tablet. 

b. Text: The user can write a text to the attribute. 

c. List: The user can choose between the options created on Makin’ Cloud.   
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i. If you choose ‘List’, you can write the options for the list. Click on ‘Option’ to 
add an option to the list: 

 

 

 

 

ii. Name the option. Click on ‘Option’ to add more options. 

 

 

 

5) Add and name more attributes if relevant. 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        147 

 

 

6) Click on ‘Save’ to save your work. 

 

 

When you have saved the work, the objects and attributes will automatically be synchronized from 

Makin’ Cloud to the project on the tablet.  

The attributes and objects you have created can be selected by long-holding the log button or 

tapping ‘Logging’ in the main menu in the Makin’ 3D app.  

 

 

 

7.8.3. Filter for overview 

The 'Filter' function allows you to search and see which attributes and objects are added for 

specific applications or geotypes. 

 
1) Click on ‘Filter’. 
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2) Select the applications and/or geotypes you want to filter. 
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3) If an attribute or object is not added for a specific application or geotype, a red eye icon will 
show that it is not visible for that application or geotype. 
 

 

 

 

 

 

 

7.9. Object information and attributes 
When a point is logged, several different pieces of information are logged together with the object 

and coordinates. Below, you can see a list of information with an explanation of the different values.  
 

 
Point name: A unique name used to identify 
individual points 

N: The measured points northern coordinate. 
This value is measured on the tool point 
 

E: The measured points’ eastern coordinate. 
This value is measured on the tool point 

H: The measured points elevation. This value is 
measured on the tool point 
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VRMS: Shows the vertical accuracy of the 
GNSS when the point was logged. Accuracy is 
defined on the GNSS antenna, not the tool 
point 

HRMS: Shows the horizontal accuracy of the 
GNSS when the point was logged. Accuracy is 
defined on the GNSS antenna, not the tool 
point 

Mount point: Shows which mount point was 
chosen for the connected NTRIP server 

Project offset: If an application has a project 
offset entered to adjust tool point elevation to 
match the elevation of a known point on the 
construction site.   

ExtSurf: Showing if the point measured is done 
on an extended surface value can be 0(no) or 
1(Yes) 

ToolHeight: Shows the height offset applied to 
the measured tool point, e.g. Pole height for 
Makin’ Survey, or Tablet height for Makin’ 
PerFormans 

Time: The time where the point was logged 
logged in a YYYY-mm-dd HH:MM:ss format 
Example: 2022-02-15 09:43:34 

SystemName: Shows the name of the system 
that logged the point. This system name 
matches the system name on the Cloud 

PDOP: Dilution Of Precision, indicates how 
errors in measurement will affect the absolute 
position calculation. Dop can be calculated in 
different variants. (HDOP, VDOP, PDOP, TDOP, 
GDOP)  
The DOP value logged in the as-built data is the 
PDOP value. (Position dilution of precision) 
This can be considered as the 3D DOP. The 
value is relative and not related to a specific 
measurement unit.  

Sats: Showing how many satellites were visible 
when the point was logged. The value is the 
sum of satellites, and not divided into specific 
satellite constellations (GPS, Glonass, Beidou, 
Galileo)  

LogOffset: Delta height. Shows if the operator 
has added an offset to the logged point. Often 
used if it is impossible to log the exact position 
due to limited space. E.g., logging the inlet in a 
manhole. Then the operator can log a point on 
the top of the manhole, measure the distance 
from the measured point to the inlet, and enter 
this as a delta height.measured. Value shows 
accuracy in meters   

SiderefFile: Side reference file. Shows the 
name of the file used as active side reference 
when point was logged 

App: Shows which system has logged this 
specific point. 

SiderefName: Side reference name. Shows the 
name of the specific reference inside the 
reference file, used as an active side reference 
when a point was logged. 

HeightOffset: If the operator has entered an 
offset, the value is documented in this field. 
This offset will have a direct effect on the Href 
value. 

Sidedist: Shows the horizontal distance from 
the tool point to the side reference when the 
point was logged. 

POI: This is set if the operator has marked a 
point as a Point Of Interest. The value can be 0 
(no) or 1 (yes). 

HeightrefFile: Height reference file. Shows the 
name of the file used as the active height 
reference when the point was logged. 
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ToolPoint: Shows which tool point was used to 
log the point. Only relevant for Excavators that 
can switch and log with Left, Center and Right 
tool point on the bucket. 

HeightrefName: Height reference name. 
Shows the name of the specific reference 
inside the reference file, used as the active 
height reference when the point was logged. 
 

Height: Shows the vertical distance from the 
tool point to the height reference when the 
point was logged. 

Comment: If the operator has written a 
comment for the point, it will be shown here. 

 
 

 

 

7.10. Sort as-built data 
Inside the reference menu, it is possible to enable sorting of the project’s as-built data. Press the AZ 

button to open the sorting dialog. 

 

 
 
 

In this dialog, you can choose which criteria you want to sort by. Press the button to activate or 

deactivate the criteria. You can also change the order you want to sort by. This is done by pressing 

and holding on a criterion and then moving it up or down the list.  

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        152 
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8. 2D functionalities 
 
In some cases, it may be beneficial to use the 2D functions embedded in the 3D system. For this to 
be an option the system requires an active license which includes the 2D.  
 
The 2D functionalities are enabled by disabling the GNSS on the system. This is done by selecting 
the option None under the submenu GNSS device, found in the GNSS menu.  
 
Please note that selecting the option None will cut off all GNSS signals to the system, turning off 
all 3D functionalities.  
 
 

 
 
When the 2D functionalities have been enabled a 2D menu will be added to the main menu, and the 
content in the different menus and on the work screen will be modified to fit the 2D system. 

 

      
 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        154 

Please note that the 2D functionalities requiring a GNSS compass will only be functioning if a 

compass is added to the system.  

When the task is completed, or a need arises for the use of the 3D functionalities. Turn on the GNSS 

to switch the system back to being a 3D system.  
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8.1. Main direction 
The Main direction function is found in the Project menu under the submenu Plane.  

Activate Plane in the menu, and you will see the direction of your work.  

• The Blue triangle will now indicate your Main slope - direction  

• The Red triangle will indicate the Side slope - direction  

• The clear triangle on the compass ring will show you the current direction of the machine. 

 

When the direction of the machine is on top of the Blue triangle, you will be on the Main slope - 
direction. 
 

• N indicates the true North direction 
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8.2. Store position 
This feature can be found in the 2D menu but are also available directly from the quick keys on the 
work screen. 

Save the excavator’s current position. The coordinates of the machine will be stored - not just the 
height, which will make it possible to move the machine to another location in a 2D environment and 
later continue work from a new location. 

An example of how to use this feature is described in the paragraph ‘Pickup position’ below. 

 
 
 

8.3. Pickup position 
This feature can be found in the 2D menu but are also available directly from the quick keys on the 
work screen. 

This feature is used to position the machine at the desired coordinate determined by the machine's 
tool. The default value given is the latest saved position by the ‘Store position’ feature described 
above, but you may specify any coordinate. 

 

An example of use: 

1) Select the tool point for one of the corners of the bucket that you wish to use to save the 
location with. You do this by tapping the bucket and then tapping on the corresponding 
corner of the bucket. 
 

2) Position the corner of your bucket on an identifiable point, like a control point - or similar 
marking. 
 

3) Tap ‘Store position’ to save the position. The position will only be available in the system’s 
memory and is not to be seen. 
 

4) Now you can move the machine anywhere to do some temporary work. 
 

5) When you want to continue working from your stored position, simply go back to your stored 
position by following steps 1 and 2 above, and this time choose ‘Pickup position’. 
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8.4. Laser height 
This feature can be found in the 2D menu. 

Enter the height of a nearby construction laser. When the laser beam hits the laser stick sensor, the 
system can use its height as a reference for the machine. 

 

 

8.5. Auto laser height 
This feature can be found in the 2D menu. 

Enabling ‘Auto laser height’ will automatically grab a laser beam from a nearby construction laser 
when hitting the machine’s laser stick sensor. This will position the machine at the height given by 
the ‘Laser height’ value - described above. 
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9 GNSS 
 
 

 
 

 

 

 

9.1. Correction source 
In the ‘GNSS’ menu, you can choose whether you want to run with the GPS receiver towards NTRIP 
(CPOS, Smartnet, TopNet) or UHF (radio) towards a local base station. If you choose UHF, you must 
select the frequency and ID that allow Makin’ 3D to communicate with the base you want. 

 

How to choose and create a correction source: 

1) Go to GNSS > Correction source 

 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        159 

 

 
 

2) In the correction source dialog, you can activate and deactivate NTRIP and UHF profiles. 
You can also create or edit a correction profile.  

 

 

 

3) To create a correction profile, tap on the + symbol. Edit a correction profile by tapping on the 
pen tool.  
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4) When tapping on the + symbol you can choose between creating a NTRIP or UHF profile. See 
the paragraphs below for more information about UHF and NTRIP. 
 
 

 
 
 
 

 

9.1.1 Radio 

Under ‘Correction source’ you see the current type of correction source being used. 

• Choose ‘UHF’ if you use a radio to connect to the correction signal. 

 

How to create a new UHF profile: 

1) You can create a new UHF profile by tapping on + symbol and then the UHF icon. 
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2) To set up the UHF profile, the following details must be entered: 
 

 
 
 

• Name: Name the UHF correction profile. 

• Bandwidth: Select either 25000Hz or 12500Hz.  

• Frequency: Tap ‘Frequency’ to set the frequency of the base station. 

• Protocol: Choose the protocol you want to use.  
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• FEC: Tap the button to activate or deactivate the FEC. 
 

• Scambling: Tap the button to activate or deactivate the scrambling. 
 

• Base ID: Tap ‘Base ID’ and choose ‘Auto’ to automatically jump between base stations with 
the same frequency or choose an ID of a specific base station to lock on to it by tapping on 
‘Custom’.  

Please note, that if you use the ‘Auto’ option, you might experience corrections from two 
bases, which is not optimal. 

 

1) Choose between ‘Auto’ or ‘Custom’ to set the Base ID. 

 

 

 

2) Tap on ‘Custom’ to choose an ID of a specific base station. 
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3) Set the ID of the specific base station you want to lock on to. Tap on the check mark to 

save.  
 

 

 
 
 

 
When you have created a UHF correction profile, you can activate the correction source you want to 
use. The current correction source will automatically deactivate. 
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8.1.2. NTRIP 

Makin is able to use corrections from several NTRIP providers. Depending on the installed GNSS 
receiver, the information must be entered by the Makin’ supporter or installer in the Makin’ 
application's GNSS menu. Makin needs some NTRIP server details to be able to connect to the server 
and receive useful corrections. These details will be delivered from the selected NTRIP provider 
when subscribing to an account. 
 

1) You can create a new NTRIP profile by tapping on the ‘+’ symbol and then the NTRIP icon. 
 

 

 
 
 

2) To connect to the NTRIP network and receive corrections, the following details must be 
entered: 
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• NTRIP name: Name the NTRIP correction profile. 
 

• NTRIP server: The web address where the server can be accessed. 
 

• NTRIP port: This is usually a 4-digit number from where Makin must receive the corrections. 
 

• NTRIP username: Every Ntrip account on the server has a unique username that Makin needs 
to log in to the server.  
 

• NTRIP password: Every Ntrip account on the server has a unique password that Makin needs 
to log in to the server.  
 

• NTRIP mountpoint: This mountpoint defines which corrections and from which GNSS 
satellites Makin can calculate an accurate position. 

 

Please note that the mountpoint is custom. You need to fill in the details for the mountpoint. 

1) Tap on ‘Mountpoint’ 
 

 

 

2) Tap on ‘Custom’ 
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3) Enter the mountpoint name. Tap on the check mark to save.  

 

 

 

When you have created a NTRIP correction profile, you can activate the correction source you want 
to use. The current correction source will automatically deactivate. 
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10. Bucket 
There is a shortcut to this menu from the quick keys. 

You will see all the buckets saved on the tablet. Tap the bucket you want to use, and always ensure 

that the calibration is correct before starting work. 

For calibration: see Chapter 13: Calibration. 

To check your calibration, see Chapter 13.3: Check the calibration of your excavator. 
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10.1. Auto-Corner 
You can manually select which corner of the bucket you want to use as the tool point, but if your 
machine has tilt, you can alternatively use the Auto-Corner function. When the Auto-Corner 
function is activated, the system automatically selects the lowest point on the bucket as the tool 
point. 
 

 
 
 
When activated, the Auto-Corner icon appears in the top bar, and it continuously indicates which 
side of the bucket you are measuring from, depending on how the bucket is tilted. 
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11. Chat 
The chat feature helps you communicate with your colleagues about the project you are working on. 
 

 
 
 

• You will see all office personnel and coworkers from your company or project. This depends 
on the structure created by your management. 
 

• Tap a contact from the list to begin messaging. 
 

 
 

• Write a message and tap ‘Send’. 
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12. Status 
This is where you will find various details about the system information. 

 

 
 

 

• Tap ‘GNSS’ to see the connection status and your location. 
 

• Tap ‘Sensors’ to see detailed sensor information. 
 

• ‘Version’ is the current Makin’ 3D software version of the Android app running on your tablet. 
 

• ‘IB-1 version’ is the firmware version of the interface box connecting all the sensors to the 
system. 

 

 

• System info: You can find all relevant information about your system by selecting ‘System 
info’. Information such as System name, System number, System owner, and the associated 
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licenses are shown here. When changes are made to the system, they will be shown under 
System info. 

 
 
 
 

13. Calibration 
13.1. Bucket calibration 
Always place your machine on the most stable surface possible and read through the full chapter 
before starting. 

 

13.1.1. Tools required 

• Spirit level 

 

• Tape measure 

 

• Plumb bob or self-leveling point laser 
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13.1.2. Before calibrating the bucket 

• For excavators with a swing boom, please ensure that the boom is aligned with the machine’s 
centerline before any calibrations are performed. 

 

 

• For excavators with tilt rotators, please center the rotating device before bucket calibration. 
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13.2. Bucket calibration menu 
Go to the bucket menu from the main screen. See Chapter 10: Bucket for further details. 

1) If you want to add a new bucket, tap the plus symbol. 

2) Tap the bucket you want to calibrate. 

 

3) Tap the pen icon to begin calibrating. 
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13.2.1. Bucket name 

In the bucket calibration, tap ‘Name’ to edit the name of the bucket. Type the name and press the 

check mark to save. 

 

 

13.2.2. Bucket tilt and quick coupler 

This step is important to do before calibrating the bucket angle (see further below). 

 
1) Tap ‘Coupler/Tilt’ to state which application is present - i.e., None, Tilt, Rotortilt. If Rotortilt is 

present, the rotor must be in the center, as stated above under Before calibrating the bucket. 

 

2) Tap ‘Tilt offset’ if you have tilt installed. Tilt the bucket until the cutting edge is horizontal, 

using a spirit level. Then tap ‘Reset’ and the check mark to save. 

 

 

 

13.2.3. Bucket width 

In the bucket calibration, tap ‘Width’ to enter the width of the bucket. The width is the total working 

width of the bucket, which you get by measuring the cutting edge. Tap the question mark icon for a 

visual guide. Tap the check mark to save. 
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13.2.4. Bucket length 

Tap ‘Length’ to enter the length of the bucket. The length is measured from the center pivot point 

at the end of the stick to the bucket’s cutting edge. Tap the question mark icon for a visual guide. 

Tap the check mark to save. 

 

 

 

• If you have a tilt-rotor application, then measure the length from both the left and right sides 
of the stick pivot bolt to the cutting edge, as the tilt may not be dead center. Use the average 
of the two measurements and apply this as the bucket length. 

 

 

 



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        176 

13.2.5. Bucket angle 

• Please make sure you have followed the instructions under Bucket tilt and Quick Coupler 
above, before continuing to calibrate the bucket angle. 
 

• Tap ‘Bucket angle’. Place the machine with the boom and stick at a height that allows you to 
open and close the bucket freely. Below, you will find two ways of calibrating the bucket 
angle: Laser option or Plumb bob option. 

 
 

13.2.6. Tilt offset 

See the description in Bucket tilt and quick coupler above. 

 

 

13.2.7. Profile angle 

• The bucket’s profile angle is optional and for visualization purposes only. 
 

• Tap ‘Profile angle’ and type in the bucket’s profile angle in the box. Tap the question mark 
icon for a visual guide. Tap the check mark to save. 

 

 

13.2.7.1. Laser option 

1) Place a self-leveling point laser on the machine frame, pointing towards the bucket center 
point. The bucket must be horizontal. 
 

2) Open the bucket until the laser hits the center of the cutting edge. The more you can open 
and close the bucket, the better the calibration result. 
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3) Tap ‘Reset’. 
 

4) Now close the bucket until the laser hits the center of the cutting edge again. 

 

 

 

5) Tap ‘Recenter’. 
 

6) Tap the check mark to save. 

 
 

13.2.7.2. Plumb bob option 

1) Place a magnet on the center of the stick’s pivot bolt to hold the plumb bob line, and let it 
hang. 
 

2) Then open the bucket if needed until the line is hanging free of the bucket. 
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3) Close the bucket until the line just touches the cutting edge of the bucket. 

 

 

4) Tap Reset and the check mark to save. 
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13.2.8. Flat angle 

1) Place a spirit level underneath the cutting edge of the bucket. Move the bucket so the cutting 

edge lies horizontally. 

 

 

2) Press ‘Reset’ if the bucket is horizontal. 

 

 

 

 

3) Click on the check mark to confirm the offset and calibrated value. 
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13.3. Check calibration of your excavator 
Before you start your daily work, we advise that a calibration check should be performed. 

Also, ensure that the machine you are going to operate is fully calibrated by a Makin’ 3D specialist 
and that your current bucket is calibrated. Follow these steps: 
 

1) You need a known point.  
 

2) You need an operational GPS and correction signal with DOP as close to 1.0 or below as 
possible. 
 

3) Place your open bucket with the cutting edge center horizontal on the point and check 
coordinates. 
 

4) Then close the bucket and place the cutting edge center at the same known point. 
 

5) If your reading is within a few centimeters of the target, your calibration is okay; otherwise, 
recalibrate. 
 

6) If you have tilt/rotor tilt, check your calibration with full tilt and different rotation angles on 
both sides. 
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13.4. Calibration backup 
You can save a backup of the machine's current calibration file. If the same tablet is used on 
different machines, you can also save each machine's calibration as a separate backup, making it 
easy to access the correct file. 
 
 

13.4.1. Snapshots 
Every hour, the snapshot function automatically creates a backup file of the current calibration, or 
whenever changes are made to the calibration. Please note, however, that if multiple changes are 
made within the same hour, the previous file will be overwritten. 
 
You can at any time change back to a previous calibration by selecting a backup file, as described 
in section 13.4.3: Select Backup File.  
 
Please note that at the end of the day, the system automatically reviews the day’s backup files and 
clears the list so that only the latest calibration remains available 
 
  
 

 

13.4.2. Manual backups 
To manually create a backup file, follow the description below.  
 

Step Action Illustration  

1 Open Machine configurations in the 
Settings menu.  
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2 Select MyMachine. 

 
3 Select Manual backups. 

 
4 Tap the + icon to create a new backup.  

 
5 Give the backup a name.  
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6 Save by tapping the check mark.  

 
NB! The backup file will now be visible in the 

Manual backups menu.  
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13.4.3. Select backup file 
Please note that the procedure for selecting a backup file is the same for snapshots and manual 
backups. 
 

Step Action Illustration  

1 Tap on the calibration file you want to 
apply to your system. 

 

 
2 A notification appears on the screen. 

Tap on the check mark to confirm. 

 
 

  



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        185 

14. Makin’ Surfaces 
Makin’ Surfaces enhances operator overview and efficiency through automatic as-built surface 
documentation and graphical visualization of project progress and completion status. 
 
Logging is done in reference to the original ground level, OGL, which is defined in the project file, 
thus ensuring that only data logged below this level is used and visualized. With Makin’ Surfaces, 
the operator will always log information about the true “bottom of cut”. 
 
The operator is continuously guided by a color-coded plot showing the bottom of the cut relative to 
the reference surface.  
 
 

14.1. Create and edit layers for Makin’ Surfaces on the tablet 
 
Select the layer that you want to log the data to. Data will always be logged at the lowest level that 
has been dug, which is the ‘Bottom’ layer. 
 
You can pause the logging in the layer by pressing the ‘Pause’ button on the layer. The logging will 
then automatically be logged in the ‘Bottom’ layer. 
 

1) Press the Makin’ Surfaces icon and select a layer. Press the ‘+’ icon to add a new layer.  
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2) Place the new layer below or above the selected layer.  

 

 
 

 
3) Enter the name of the new layer. In this case, it's called "Vegetation." Press OK. 
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The color of the heat map is, by default, determined by the reference height. 
 

The Makin’ Surfaces heat map will be colored according to the height tolerance colors and will be 
updated when the height tolerances are changed.  

 
When working outside the model, the coloring will be gray. 

 
Please note that Surface logging is not meant to be used on local projects, since the data created in 
some cases can fill up the tablet storage. 

 
 

14.2. Change coloring from Reference height to Fixed 
 

1) Press the icon for Makin’ Surfaces. Press the pen icon to edit. 
 

2) Select Coloring and change the coloring to a fixed color. 
 

 

 
 
 

 
3) Select a color. Press OK to close the window. 
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4) Press the arrow to close. The surface will now be colored with the selected color. When 

working outside the model, the color will have another tint. 
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14.3. Hide the Makin’ Surfaces layers 
 

1) Hide the logging by pressing the eye icon. Press the arrow to close the window. 
 

 

 
 
 

 
The logged surfaces will not be shown persistently on the screen but only transiently. 
 

2) Press the eye icon to show the logged surfaces again. 
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14.4. Enhance the display of the Makin’ Surfaces layers 
 

• Long-hold on the Makin’ Surfaces icon if you need to emphasize the surface for better 
visibility. 
 
 

 
 

 
 
The surfaces will now be shown in a stronger color and with a denser point cloud. 
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15. Troubleshooting 
 

Error message Possible cause Possible Solution 

   

   

   

   

   

   

   

   

   

   

   

   

 

If you cannot solve the problem using the advice found in the above table, contact your reseller. 
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16. Appendix 

16.1. Software updates 

When updating the Makin’ 3D app to a new version, you might receive a notification from Google 

Play Protect. To proceed with the installation, allow Google Play Protect to scan the app. This 

ensures the new software version is safe to install. 

 
1) Tap on ‘Scan app’. 

 

 
 

 
 

2) Tap ‘Install’. 
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3) The Makin’ 3D app is now updating to a new software version. Please wait while the update 

is installed. 
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16.2. GNSS limitations 
Always take into consideration where your machine is located. Especially when 
the construction site is within city limits with tall buildings or other obstacles. 

Also, if working near forest and mountain areas, interference could block the 
signal from one or more satellites and cause poor precision. Reflections could also occur. 

Makin’ 3D will inform you if there are not enough visible satellites or if your CQ/DOP is too high. 

 

 

 
1. Direct signal blocked 

 
3. Multipath errors 

 
2. Direct signals perfectly received   
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16.3. Frequency 
 

In situations where you have to specify the frequency according to a channel, refer to the table below 
for guidance. Channel 0 is the center frequency, and channels are distributed with a 25 kHz spacing 
(in this example). 

 

Channel Frequency (MHz) 

0 446.6000 

-1 446.5750 

-4 446.5000 

-5 446.4750 

 

  



 

                                       Makin' Excavator 3D User guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS        196 

16.4. Compliance information 

This product is intended to be mounted on earth-moving machinery exclusively for professional use, 

i.e. the product falls into the category: non-road vehicles exclusively for professional use. Makin 

hereby declares that the system and its components fulfill the requirements of the following EU 

directives applicable to this product category: 

 
 

• 93/68/EEC - CE conformity marking 

• 2014/53/EU - Radio Equipment Directive 

• 2014/30/EU - EMC directive 

○ DS/EN/ISO 13766-1:2018 - Earth-moving and building construction machinery — 

Electromagnetic compatibility (EMC) of machines with internal electrical power 

supply — Part 1: General EMC requirements under typical electromagnetic 

environmental conditions 

○ DS/EN/ISO 13766-2:2018 - Earth-moving and building construction machinery — 

Electromagnetic compatibility (EMC) of machines with internal electrical power 

supply — Part 2: Additional EMC requirements for functional safety 

 
 
 
The respective product category falls outside the scope of these directives: 
 

• 2011/65/EU - RoHS 

• 2012/19/EU - WEEE 
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16.5. Tablet connections 

16.5.1. Tablet Panasonic FZ-A3 connections 

The Panasonic FZ-A3 has connectors located in four places: on the top, on the side, inside the battery 
compartment, and at the bottom. 

 

 

 

 1. Mini-jack audio output  4. 16 V DC input power for external 
charger 

 2. Micro SIM card for broadband internet 
on both tablet and GNSS receiver 

 5. USB-A  

 3. Docking station connector for data and 
power transmission 
 

 6. USB-C 
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16.5.2. Tablet Panasonic FZ-A2 connections 

The Panasonic FZ-A2 has connectors on the top, on the side, inside the battery compartment, and 
at the bottom. 

 

 

 

 1. 16 V DC input power for external 
charger 

 5. HDMI output to external screen 

 2. Docking station connector for data and 
power transmission 

 6. SuperSpeed USB-A 3.0 

 3. Micro SIM card for broadband internet 
on both tablet and GNSS receiver 

 7. Mini-jack audio output 

 4. USB-C  8. Micro SD for extended storage 
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16.6. Docking station connections 
 

 

 

 1. 16 V DC input power for external 
charger 

 
 

3. 2x HighSpeed USB-A 2.0 

 2. RJ-45 Ethernet   
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16.7. Tablet set-up 

16.7.1. Tablet buttons and light indicators (Panasonic FZ-A2) 

 
 

1. 1. On/Off button 6. 4. Auto-rotate screen. The button can be 
programmed (more info below). 

2. 2. Power indicator 
• No light: System is off 
• Green light: System is on 
• Blinking green light: Tablet in sleep 

mode 

7. 5. Volume up 
 
6. Volume down 
 

7. Not in use. The button can be 
programmed (See section 16.7.2. below). 
 

8. Not in use. The button can be 
programmed (See section 16.7.2. below). 
 

9. Basic tablet functionality via the 
‘Dashboard’ app. The button can be 
programmed (See section 16.7.2. below). 

3. 3. Charging indicator 

• No light: External power source 
not connected 

• Red light: Battery power is 
critically low. External power 
source is not connected. 

• Orange light: Tablet is currently 
charging 

• Green light: Tablet fully charged 

8. 
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16.7.2. Programming the physical tablet buttons 
The Panasonic tablet has three user-programmable function keys, A1, A2, and A3. You can assign 
Makin’ 3D functions to these keys. 
 

Step Action Illustration 
1 Open the app UserButtonManager.   

 
 
 

2 Select the physical button to which you 
want to assign the Makin’ 3D function (A1, 
A2 or A3).  

 

 

 
 3 When clicked, a pop-up window will open. 

Select the desired function — it will be 
labelled Program 1, Program 2 or Program 3 
depending on the button you select in the 
Makin’ 3D app. 
 

 

 
 

4 Go to the Settings menu in the Makin’ 3D 
app.  
 

 

 

 

5 Open the External Buttons menu. 
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6 Click the button you want to program 
(Program 1, Program 2 or Program 3).  
 
Note:  
If the button does not appear on the list, 
press the physical button, this will add the 
option to the list.  
 

 

 

 
7 Select the function you want to assign to 

the button.  
 

 

 

 
8 Check that the function has been assigned 

to the button. The function appears beneath 
the button name. If a button has not been 
programmed, it will show the description No 
action. 
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16.8. Interface Box (IB-1) 
Status information on the interface module can be read out by watching the LED just next to the 

power connector. 

 

 

Color                                  Indication 

Green ON - all ok 

Flashing red Firmware issue - contact reseller 

White System check of software 

Blue Updates to software are ongoing 
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16.9. Demo mode 
You can use your Makin’ 3D system on Windows in demo mode to gain confidence in the user 
interface. 

Please find below the shortcuts for the functions. 
 

Keyboard Action  

← Rotate camera left 

→ Rotate camera right 

↓ Tilt camera down 

↑ Tilt camera up 

Space  Start/stop automatic driving  

+ Raise machine model 

- Lower machine model  

. Change view (sampling through options) 

b Rotate cab left 

Shift b / B Rotate cab right 

m Rotate cab right 

Shift m / M Rotate cab left 

n Drive forward (in direction of cab orientation) 

Shift n / N Drive backwards (in direction of cab orientation) 

s Drive forward along pre-determined line (centreline) 

Shift s / S Drive backwards along pre-determined line (centreline) 
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j Jump around close to the project 

Shift j /J Jumps to the roundabout in Odense S 

u Jump to current side reference 

p Opens the Plane menu 

o Opens the offset menu 

g Opens the jog window  

w Activate/deactivate wireframe mode  

r Refresh / Finds the model  

R Reload / reset model orientation (undoes number key modifications) 

1 Tilt model to the left (Roll) 

Alt 1 Tilt model to the right (Roll) 

2 Tilt model forward (Pitch) 

Alt 2 Tilt model backwards (Pitch)  

3 Rotate tracks to the right 

Alt 3  Rotate tracks to the left  

4 / 5 / 6 / 7 / 8 / 9 Move a machine part – follow the machine from the boom outwards 
to the bucket. The connection between the key and the machine part 
depends on the machine’s configuration. 

Alt 4 / 5 / 6 / 7 / 8 / 9  Reverses the movement   
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16.10. Xbox controller  

You can use an Xbox controller to control the machine model in the Makin’ 3D app on your tablet. It 

is an easy way to gain confidence in the user interface. This feature is only available when you 

connect the Xbox controller to a Panasonic FZ-A3 tablet.  

 

How to connect the Xbox controller to your tablet: 

1. Go to Settings on your tablet.  

 

2. Click on Connected devices. 

 

3. Press the connect button on the Xbox controller. The button is located on on top of the 

controller (Number 4 on the image below). 

 

4. Click on Pair new device. 

 

5. Click on the available Xbox Wireless Controller on the tablet screen. Wait for the devices to 

pair. 

 

6. Your Xbox controller is now connected to the tablet and ready for use.  

 

Please note:  

The available functions depend on the machine model activated on the tablet. Use the table below 

to see the button functions for this model. 
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Button direction Dig mode Drive mode 

1 Press down Switch to drive mode Switch to dig mode 

1 Forward Arm out Drive forward 

1 Backwards Arm in Drive backwards 

1 left Swing left Turn machine left 

1 right Swing right Turn machine right 

2 Tilt left Decrease turbo (stepwise) 

3 - - 

4 Connect controller 
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5 Power on/off 

6 Jump to side reference 

7 - - 

8 Tilt right Increase turbo (stepwise) 

9 - - 

10 - - 

11 - - 

12 forward Boom down Pitch machine down 

12 backwards Boom up Pitch machine up 

12 left Close bucket  Roll machine left 

11 right Open bucket Roll machine right 

A Move machine down to 1 meter 

B Rotate bucket right 

X Rotate bucket left 

Y Move machine up 1 meter 
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